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Overview
Feather is the new development board from Adafruit, and like it's namesake it is thin, light, and lets
you fly! We designed Feather to be a new standard for portable microcontroller cores.

At the Feather M0's heart is an ATSAMD21G18 ARM Cortex M0 processor, clocked at 48 MHz and
at 3.3V logic, the same one used in the new Arduino Zero (http://adafru.it/2843). This chip has a
whopping 256K of FLASH (8x more than the Atmega328 or 32u4) and 32K of RAM (16x as much)!
This chip comes with built in USB so it has USB-to-Serial program & debug capability built in with no
need for an FTDI-like chip.
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To make it easy to use for portable projects, we added a connector for any of our 3.7V Lithium
polymer batteries and built in battery charging. You don't need a battery, it will run just fine straight
from the micro USB connector. But, if you do have a battery, you can take it on the go, then plug in
the USB to recharge. The Feather will automatically switch over to USB power when its available.
We also tied the battery thru a divider to an analog pin, so you can measure and monitor the battery
voltage to detect when you need a recharge.
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Here's some handy specs!

Measures 2.0" x 0.9" x 0.28" (51mm x 23mm x 8mm) without headers soldered in
Light as a (large?) feather - 4.6 grams
ATSAMD21G18 @ 48MHz with 3.3V logic/power
256KB of FLASH + 32KB of RAM
32.768 KHz crystal for clock generation & RTC
3.3V regulator with 500mA peak current output
USB native support, comes with USB bootloader and serial port debugging
You also get tons of pins - 20 GPIO pins
Hardware Serial, hardware I2C, hardware SPI support
PWM outputs on all pins
6 x 12-bit analog inputs
1 x 10-bit analog ouput (DAC)
Built in 100mA lipoly charger with charging status indicator LED
Pin #13 red LED for general purpose blinking
Power/enable pin
4 mounting holes
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Reset button

The Feather M0 Basic Proto has some extra space left over, so we give you a tiny little prototyping
area. If you just need to attach a button or sensor, you may be able to skip out on a breadboard and
wire it directly on there. 

Comes fully assembled and tested, with a USB bootloader that lets you quickly use it with the
Arduino IDE. We also toss in some header so you can solder it in and plug into a solderless
breadboard. Lipoly battery and USB cable not included (but we do have lots of options in the
shop if you'd like!)
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Pinouts
The Feather M0 Basic is chock-full of microcontroller goodness. There's also a lot of pins and ports.
We'll take you a tour of them now!

Power Pins
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GND - this is the common ground for all power and logic
BAT - this is the positive voltage to/from the JST jack for the optional Lipoly battery
USB - this is the positive voltage to/from the micro USB jack if connected
EN - this is the 3.3V regulator's enable pin. It's pulled up, so connect to ground to disable the
3.3V regulator
3V - this is the output from the 3.3V regulator, it can supply 500mA peak

Logic pins
This is the general purpose I/O pin set for the microcontroller. 
All logic is 3.3V
All pins can do PWM output
All pins can be interrupt inputs

#0 / RX - GPIO #0, also receive (input) pin for Serial1 (hardware UART), also can be analog
input
#1 / TX - GPIO #1, also transmit (output) pin for Serial1, also can be analog input 
#20 / SDA - GPIO #20, also the I2C (Wire) data pin. There's no pull up on this pin by default
so when using with I2C, you may need a 2.2K-10K pullup.
#21 / SCL - GPIO #21, also the I2C (Wire) clock pin. There's no pull up on this pin by default
so when using with I2C, you may need a 2.2K-10K pullup.
#5 - GPIO #5
#6 - GPIO #6
#9 - GPIO #9, also analog input A7. This analog input is connected to a voltage divider for the
lipoly battery so be aware that this pin naturally 'sits' at around 2VDC due to the resistor
divider
#10 - GPIO #10
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#11 - GPIO #11
#12 - GPIO #12
#13 - GPIO #13 and is connected to the red LED next to the USB jack
A0 - This pin is analog input A0 but is also an analog output due to having a DAC (digital-to-
analog converter). You can set the raw voltage to anything from 0 to 3.3V, unlike PWM
outputs this is a true analog output
A1 thru A5 - These are each analog input as well as digital I/O pins.
SCK/MOSI/MISO (GPIO 24/23/22)- These are the hardware SPI pins, you can use them as
everyday GPIO pins (but recommend keeping them free as they are best used for hardware
SPI connections for high speed.

Other Pins!
RST - this is the Reset pin, tie to ground to manually reset the AVR, as well as launch the
bootloader manually
ARef - the analog reference pin. Normally the reference voltage is the same as the chip logic
voltage (3.3V) but if you need an alternative analog reference, connect it to this pin and select
the external AREF in your firmware. Can't go higher than 3.3V!

SWCLK & SWDIO - These pads on the bottom are used to program the chip. They can also
be connected to an SWD debugger.

© Adafruit Industries https://learn.adafruit.com/adafruit-feather-m0-basic-proto Page 10 of 29



 

© Adafruit Industries https://learn.adafruit.com/adafruit-feather-m0-basic-proto Page 11 of 29



Power Management

Battery + USB Power
We wanted to make the Feather easy to power both when connected to a computer as well as via
battery. There's two ways to power a Feather. You can connect with a MicroUSB cable (just plug
into the jack) and the Feather will regulate the 5V USB down to 3.3V. You can also connect a
4.2/3.7V Lithium Polymer (Lipo/Lipoly) or Lithium Ion (LiIon) battery to the JST jack. This will let the
Feather run on a rechargable battery. When the USB power is powered, it will automatically
switch over to USB for power, as well as start charging the battery (if attached) at 100mA.
This happens 'hotswap' style so you can always keep the Lipoly connected as a 'backup' power that
will only get used when USB power is lost.
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The above shows the Micro USB jack (left), Lipoly JST jack (top left), as well as the 3.3V regulator
and changeover diode (just to the right of the JST jack) and the Lipoly charging circuitry (to the right
of the Reset button). There's also a CHG LED, which will light up while the battery is charging. This
LED might also flicker if the battery is not connected.

Power supplies
You have a lot of power supply options here! We bring out the BAT pin, which is tied to the lipoly
JST connector, as well as USB which is the +5V from USB if connected. We also have the 3V pin
which has the output from the 3.3V regulator. We use a 500mA peak regulator. While you can get
500mA from it, you can't do it continuously from 5V as it will overheat the regulator. It's fine for, say,
powering an ESP8266 WiFi chip or XBee radio though, since the current draw is 'spikey' & sporadic.
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Measuring Battery
If you're running off of a battery, chances are you wanna know what the voltage is at! That way you
can tell when the battery needs recharging. Lipoly batteries are 'maxed out' at 4.2V and stick
around 3.7V for much of the battery life, then slowly sink down to 3.2V or so before the protection
circuitry cuts it off. By measuring the voltage you can quickly tell when you're heading below 3.7V

To make this easy we stuck a double-100K resistor divider on the BAT pin, and connected it to D9
(a.k.a analog #7 A7). You can read this pin's voltage, then double it, to get the battery voltage.

ENable pin
If you'd like to turn off the 3.3V regulator, you can do that with the EN(able) pin. Simply tie this pin to
Ground and it will disable the 3V regulator. The BAT and USB pins will still be powered

#define VBATPIN A7
   
float measuredvbat = analogRead(VBATPIN);
measuredvbat *= 2;    // we divided by 2, so multiply back
measuredvbat *= 3.3;  // Multiply by 3.3V, our reference voltage
measuredvbat /= 1024; // convert to voltage
Serial.print("VBat: " ); Serial.println(measuredvbat);
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Arduino IDE Setup
The first thing you will need to do is to download the latest release of the Arduino IDE. You will need
to be using version 1.6.4 or higher for this guide.

Arduino IDE v1.6.4+ Download

http://adafru.it/f1P

After you have downloaded and installed v1.6.4, you will need to start the IDE and navigate to the
Preferences menu. You can access it from the File menu in Windows or Linux, or the Arduino
menu on OS X.

A dialog will pop up just like the one shown below.
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We will be adding a URL to the new Additional Boards Manager URLs option. The list of URLs is
comma separated, and you will only have to add each URL once. New Adafruit boards and updates
to existing boards will automatically be picked up by the Board Manager each time it is opened. The
URLs point to index files that the Board Manager uses to build the list of available & installed
boards.

To find the most up to date list of URLs you can add, you can visit the list of third party board URLs
on the Arduino IDE wiki (http://adafru.it/f7U). We will only need to add one URL to the IDE in this
example, but you can add multiple URLS by separating them with commas. Copy and paste
the link below into the Additional Boards Manager URLs option in the Arduino IDE preferences.

https://adafruit.github.io/arduino-board-index/package_adafruit_index.json
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Here's a short description of each of the Adafruit supplied packages that will be available in the
Board Manager when you add the URL:

Adafruit AVR Boards - Includes support for Flora, Gemma, Feather 32u4, Trinket, & Trinket
Pro.
Adafruit SAMD Boards - Includes support for Feather M0
Arduino Leonardo & Micro MIDI-USB - This adds MIDI over USB support for the Flora,
Feather 32u4, Micro and Leonardo using the arcore project (http://adafru.it/eSI).

Click OK to save the new preference settings. Next we will look at installing boards with the Board
Manager.

Make sure you remove the apt.adafruit.com proxy setting from the Arduino preferences if you
have previously added it.�
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Using with Arduino IDE
Since the Feather M0 uses an ATSAMD21 chip running at 48 MHz, you can pretty easily get it
working with the Arduino IDE. Most libraries (including the popular ones like NeoPixels and display)
will work with the M0, especially devices & sensors that use i2c or SPI.

Now that you have added the appropriate URLs to the Arduino IDE preferences, you can open the
Boards Manager by navigating to the Tools->Board menu.

Once the Board Manager opens, click on the category drop down menu on the top left hand side of
the window and select Contributed. You will then be able to select and install the boards
supplied by the URLs added to the prefrences.

Install SAMD Support
First up, install the Arduino SAMD Boards version 1.6.2 
or later
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Install Adafruit SAMD
Next you can install the Adafruit SAMD package to add the board file definitions
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Even though in theory you don't need to - I recommend rebooting the IDE

Quit and reopen the Arduino IDE to ensure that all of the boards are properly installed. You
should now be able to select and upload to the new boards listed in the Tools->Board menu.

Install Drivers (Windows Only)
When you plug in the Feather, you'll need to possibly install a driver

Start out by installing the serial/CDC drivers. We'll be using PJRC's awesome generic CDC drivers,
works with all Windows and all CDC devices. (Thanks Paul!) (http://adafru.it/fLA)
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Mac/Linux does not need a driver, continue as is!

Blink
Now you can upload your first blink sketch!

Plug in the Feather M0 and wait for it to be recognized by the OS (just takes a few seconds). It will
create a serial/COM port, you can now select it from the dropdown, it'll even be 'indicated' as
Feather M0!

Now load up the Blink example

And click upload! That's it, you will be able to see the LED blink rate change as you adapt the
delay() calls.

// the setup function runs once when you press reset or power the board
void setup() {
  // initialize digital pin 13 as an output.
  pinMode(13, OUTPUT);
}

// the loop function runs over and over again forever
void loop() {
  digitalWrite(13, HIGH);   // turn the LED on (HIGH is the voltage level)
  delay(1000);              // wait for a second
  digitalWrite(13, LOW);    // turn the LED off by making the voltage LOW
  delay(1000);              // wait for a second
}
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Sucessful Upload
If you have a successful upload, you'll get a bunch of red text that tells you that the device was
found and it was programmed, verified & reset

Compilation Issues
If you get an alert that looks like

Cannot run program "{runtime.tools.arm-none-eabi-gcc.path}\bin\arm-non-eabi-g++"

Make sure you have installed the Arduino SAMD boards package, you need both Arduino &
Adafruit SAMD board packages
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Manually bootloading
If you ever get in a 'weird' spot with the bootloader, or you have uploaded code that crashes and
doesn't auto-reboot into the bootloader, click the RST button twice (like a double-click)to get back
into the bootloader.

The red LED will pulse, so you know that its in bootloader mode.

Once it is in bootloader mode, you can select the newly created COM/Serial port and re-try
uploading.

You may need to go back and reselect the 'normal' USB serial port next time you want to use the
normal upload.
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Ubuntu & Linux Issue Fix
Note if you're using Ubuntu 15.04 (or perhaps other more recent Linux distributions) there is an
issue with the modem manager service which causes the Bluefruit LE micro to be difficult to
program.  If you run into errors like "device or resource busy", "bad file descriptor", or "port is busy"
when attempting to program then you are hitting this issue. (http://adafru.it/fP6)

The fix for this issue is to make sure Adafruit's custom udev rules are applied to your system.  One
of these rules is made to configure modem manager not to touch the Feather board and will fix the
programming difficulty issue.  Follow the steps for installing Adafruit's udev rules on this
page. (http://adafru.it/iOE)
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Adapting Sketches to M0
The ATSAMD21 is a very nice little chip but its fairly new as Arduino-compatible cores go. Most
sketches & libraries will work but here's a few things we noticed!

Analog References
If you'd like to use the ARef pin for a non-3.3V analog reference, the code to use is
analogReference(AR_EXTERNAL)  (it's AR_EXTERNAL not EXTERNAL)

Pin Outputs & Pullups
The old-style way of turning on a pin as an input with a pullup is to use

pinMode(pin, INPUT)
digitalWrite(pin, HIGH)

This is because the pullup-selection register is the same as the output-selection register.

For the M0, you can't do this anymore! Instead, use

pinMode(pin, INPUT_PULLUP)

which has the benefit of being backwards compatible with AVR.

Serial vs SerialUSB
99.9% of your existing Arduino sketches use Serial.print to debug and give output. For the M0
core, this goes to the Serial5 port, which isn't exposed on the Feather. The USB port, is called
SerialUSB instead.

You've got two options. If you want your Serial prints and reads to use the USB port, use SerialUSB
instead of Serial in your sketch

If you have existing sketches and code and you want them to work with the M0 without a huge find-
replace, put

#define Serial SerialUSB

right above the first function definition in your code. For example:
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Bootloader Launching
For most other AVRs, clicking reset while plugged into USB will launch the bootloader manually, the
bootloader will time out after a few seconds. For the M0, you'll need to double click the button. You
will see a pulsing red LED to let you know you're in bootloader mode. Once in that mode, it wont
time out! Click reset again if you want to go back to launching code

Aligned Memory Access
This is a little less likely to happen to you but it happened to me! If you're used to 8-bit platforms,
you can do this nice thing where you can typecast variables around. e.g.

uint8_t mybuffer[4];
float f = (float)mybuffer;

You can't be guaranteed that this will work on a 32-bit platform because mybuffer might not be
aligned to a 4-byte boundary. Instead, use memcpy!

uint8_t mybuffer[4];
float f;
memcpy(f, mybuffer, 4)
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Downloads
Datasheets

ATSAMD21 Datasheet (http://adafru.it/jEZ) (the main chip on the Feather M0)

Schematic
Click to enlarge

Fabrication Print
Dimensions in inches
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